COUNTY OF LOS ANGELES - DEPARTMENT OF MENTAL HEALTH

Naga Kasarabada, Ph.D., Chair

PROGRAM SUPPORT BUREAU

Departmental Quality Improvement Council Meeting

AGENDA

March 14, 2016
9:00 — 10:30 a.m.

550 S. Vermont Ave., 10" Floor Conference Room

Los Angeles, CA 90020

Karen Lee, M.D.,/Carol Eisen, M.D., Co-Chairs

I 9:00 - 9:05 Introductions & Review of Minutes QIC Members
I | 9:05-9:15 Clinical Quality Improvement K. Lee
» OMD Report M. O’Donnell
| 9:15-9:40 » Systems Review
» Language Interpreters Policy N. Kasarabada
» EQRO Review
> SA Ql Project
» CSECY PIP
» Survey to Review Agency QI Process
IV | 9:40 - 9:50 » Provider Directory V. Joshi
V ] 9:50-10:10 Consumer Participation at SA QICs. H. Ditko
VI | 10:10 - 10:20 Patients’ Rights Office M. Hernandez
» Change of Provider Request Log J. Walker
VIl | 10:20 — 10:25 Cultural Competency Updates S. Chang
Ptasinski
VIl | 10:25 - 10:30 Policy Update — Office of Compliance R. Faveau

Announcements:

Next Meeting
April 11, 2016
9:00 — 10:30 a.m.
550 S. Vermont Ave. 10" Floor Conference Room
Los Angeles, CA 90020




COUNTY OF LOS ANGELES - DEPARTMENT OF MENTAL HEALTH
QUALITY IMPROVEMENT COUNCIL (QIC) Minutes

Type of Meeting Departmental Date: March 14, 2016
Quality Improvement Council
Place 550 S. Vermont Ave., 10" Floor Start Time: 9:00 a.m.
Conf. Rm.
Chair Naga Kasarabada, Ph.D. End Time: 10:30 a.m.
Co-Chair Carol Eisen, M.D./Karen Lee, M.D.

Members Present

Ann Lee; Antonio Banuelos; Aprill Baker; Bertrand Levesque; Caesar Moreno; David Tavlin; Debra Mahoney; Debi
Berzon-Leitelt; Elizabeth Dandino; Emilia Ramos; Gassia Ekizian; Greg Tchakmakjian; Julie Loeb; Karen Lee;
Kimber Salvaggio; Lisa Harvey; LyNetta Gore; Margaret Faye; Maria Gonzalez; Martin Hernandez; Mary Ann
O’Donnell; Mary Camacho Fuentes; Michael Tredinnick; Michelle Munde; Michelle Rittel; Misty Aranoff; Monika
Johnson; Randolph Faveau; Tonia Amos Jones; Vandana Joshi

Excused/Absent
Members

Anna Levina; Barbara Paradise; Carol Eisen; Elisabeth Gildemontes; Helena Ditko; Jamie Walker; Kary To; Leticia

Ximenez; Sandra Chang-Ptasinski

Agenda Item &
Presenter

Discussion and Findings

Decisions, Recommendations,
Actions, & Scheduled Tasks

Person
Responsible

Call to Order &
Introductions

The meeting was called to order at 9:00 a.m.

QIC members attended this meeting.

Dr. Kasarabada

Review of Minutes

The January minutes were reviewed.

Minutes were reviewed and approved as
noted.

QIC Membership
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Page 2
Agenda Item & Discussion & Findings Decisions, Recommendations, Person
Presenter Actions, & Scheduled Tasks Responsible
SA QIC’s Reports SA 1: A presentation on SB 82 navigation mobile Next meeting: March 1, 2016. D. Berzon-Leitelt
& Countywide triage team was conducted. Presentation was very
Children’s QIC successful. Test Calls Study was discussed, and
Report volunteers were selected.

SA 2: Ms. Salvaggio provided an update on a Next meeting: March 17, 2016. K. Salvaggio
discussion that was presented on their SA Adult QI
meeting that included San Fernando Valley
Community MH Center, Inc. sharing their best
practices with the group, specifically on how they
utilize and share their data from the MHSIP surveys
with staff and consumers. Also presented updates
from Departmental QIC meeting.

SA 2 Children: There was a joint meeting with SA 2 [ Next meeting: February 18, 2016. M. Rittel
Adult.
SA 3: Information from previous Departmental QIC [ Next meeting: February 17, 2016. B. Levesque

meeting was discussed. MHSIP survey data was
also discussed.

SA 4: Mr. Vidaurri was present and provided DMH [ Next meeting: February 16, 2016. L. Harvey
update to the group. Staff interested on SA QIC chair
position. Also presented updates from Departmental
QIC meeting.

SA 5: Discussion focused on upcoming Next meeting: March 1, 2016 M. Johnson
Chart/System Review and update on various QI
activities regarding PRO, SA Access Center Test
Calls, and SA Provider Directories. Also discussed
the MHSIP Spring Survey Subscale results.
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Agenda Iltem &
Presenter

Discussion & Findings

Decisions, Recommendations,
Actions, & Scheduled Tasks

Person
Responsible

SA QIC’s Reports
& Countywide
Children’s QIC
Report Cont.

Clinical Quality
Improvement
OMD Report

SA 6: No report

SA 7: Information from previous Departmental QIC
meeting was disseminated. Dr. Jones provided an
update on MHSIP survey data.

SA 8: Information from previous Departmental QIC
meeting was disseminated. Starting to prepare staff
for the Test Calls, volunteers are needed.

Countywide Children’s: A 15 minutes presentation
on SB 785 Authorization Process and Robert Trujillo’s
presentation on Wraparound program is scheduled
for the next meeting.

The final report of the 2013 Peer Review, which was
presented to the Executive Management Team in
October of 2015, was presented. The review focused
on how many records of client receiving psychotropic
medications contained a BMI and Outpatient
Medication Review (OMR) which listed their current
medications. It was determined that 34% of the
clients did have a BMI documented, 74% of the
records did have a completed OMR and that 71% of
the records contained an OMR dated within the past
year. Follow-up was done with the clients who did
not have one in their record.

Next meeting: February 16, 2016.

Next meeting: February 17, 2016.

Next meeting: February 11, 2016.

A. Banuelos

M. Munde

D. Mahoney

M. O’Donnell
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Agenda Item & Discussion & Findings Decisions, Recommendations, Person
Presenter Actions, & Scheduled Tasks Responsible
Clinical Quality The Regional Medical Directors or Supervising M. O’Donnell
Improvement Psychiatrists have apprised prescribers of the
OMD Report requirement to document a BMI yearly for clients
Cont. prescribed an antipsychotic medication as stated in

Test Calls Report CY
2015

DMH 3.7 Parameters For General Health-Related
Monitoring in Adults. Additionally, in 2015, the
department adopted the Meaningful Use
measurement of documenting the BMI for all clients.
The parameters were revised in October of 2015 to
reflect this measurement.

Dr. Kasarabada reviewed the test calls findings for
CY 2015 and trends over the past five years.
Hundred percent of the test calls were completed.
She highlighted the improvement in the satisfaction
related to interpreter services on the test calls over
the past two years. However, she noted that there
are areas for improvement such as logging of calls,
inquiry regarding crisis situations, documentation of
the name of caller, and satisfaction with ACCESS
Center customer service. She explained that the
test calls study results were presented to ACCESS
Center staff and management and important
feedback was received that has been used to revise
the test calls survey form for CY 2016. Test callers
are requested to listen carefully to the entire initial
greeting to note the name of the agent which is
announced towards the end of the greeting. SA QIC
Chairs suggested that ACCESS Center consider
shortening the length of the greeting to make it
easier for callers to note the name.

The test calls report for CY 2015 has been
posted on the PSBQI website. All SA QIC
Chairs were requested to send the test
calls survey results using the online form
and to carefully review the test call forms
in a timely manner to ensure there is no
missing data prior to submitting to QID.

N. Kasarabada



http://file.lacounty.gov/dmh/cms1_159946.pdf
http://file.lacounty.gov/dmh/cms1_159946.pdf
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Agenda Item & Discussion & Findings Decisions, Recommendations, Person
Presenter Actions, & Scheduled Tasks Responsible
Test Calls Test Calls | The issues specific to individual test calls have been N. Kasarabada
Report CY 2015 addressed by ACCESS Center supervisors with staff
continued to ensure quality improvement on future calls. The

Provider Directory

PIP Updates —
CSECY,

schedule for the CY 2016 has been revised to
ensure test calls are conducted during each quarter
per the recent State requirement. The revised
survey form allows test callers to select more than
one reason for satisfaction with interpreter services
and ACCESS Center agent.

Dr. Kasarabada stated that the Provider Directory
(PD) was translated into 11 threshold languages in
time for the Systems Review and will be presented
for the review scheduled for this week. The updated
PD has a revised classification into 5 categories —
outpatient, community outreach services, 24
hour/residential, crisis services and juvenile justice.
She explained that QID team has worked on this
project extensively to accomplish this cultural
competence objective to have this available for
consumers in threshold languages. The PD has
been field tested majority of the translations and a
few are pending.

Dr. Kasarabada presented updates on the Clinical
PIP — Commercial Sexual Exploitation of Children
and Youth (CSECY) and the Non-Clinical PIP-
Vacancy Adjustment Notification System (VANS).
QID is working collaboratively to gather CSECY
clients identified by clinicians trained on CSECY and
related outcomes. Clinicians from directly operated
(DO) clinics can upload their client list on the
SharePoint site created by QID or send their list via
secure email to the CSECY mailbox created by the
Transitional Age Youth (TAY) Division . Two training
webinars were provided to demonstrate the process
to upload this information.

The PD will be posted on the PSBQI
website once all versions are finalized and
SA QIC Chairs will be notified. SA QIC
Chairs requested a demo of the PD
information including the Service Locator.
Dr. Kasarabada stated that a demo would
be planned in the near future.

QIC Chairs are requested to remind
clinicians from DO clinics and contract
clinics to send their client lists to the TAY
Division to improve the tracking of CSECY
clients.

N. Kasarabada

N. Kasarabada
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Agenda Item & Discussion & Findings Decisions, Recommendations, Person
Presenter Actions, & Scheduled Tasks Responsible
VANS The VANS application is currently implemented for  ACCESS Center will have access to N. Kasarabada

QID Liaisons Update
at SAQIC’s

MHSIP Report May
2015
MHSIP May 2016

SA s 4 and 5 and QID will be moving forward with
SAs 6 and 8 for the next phase. Training webinars
will be provided to providers in these SAs to
implement VANS. The PIP committee has been
closely working with the Service Request Tracking
System (SRTS) DMH leads and Chief Information
Office Bureau (CIOB) to establish the SRTS VANS
link for SRTS users to access vacant slot information
on VANS to facilitate timely referrals.

Dr. Kasarabada stated that the two QID liaisons, Dr.
Jones and Dr. Gore will be presenting consistent Ql
updates at their respective SA QIC meetings as a
follow up to Departmental QIC meeting information
presented. For example, the May MHSIP survey
data specific to the SAs compared to Countywide
information and potential areas for improvement and
the test calls study results will be presented at the
upcoming meetings.

Dr. Joshi presented on the Spring 2015 Report. A
total of MHSIP surveys were returned by providers.
The May 2015 MHSIP report will be uploaded to the
PSBQI website. The report has been finalized and
Provider Tables have been prepared. The QI
Liaisons (Drs. Jones and Dr. Gore) will be discussing
these tables in their respective SA QI meetings.
Some highlights from the report were:

VANS once all SAs are included in VANS.

SA QIC Chairs can coordinate
presentation of this information at the
upcoming QIC meetings.

N. Kasarabada

V. Joshi
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Agenda Item & Discussion & Findings Decisions, Recommendations, Person
Presenter Actions, & Scheduled Tasks Responsible

MHSIP Report May
2015

MHSIP May 2016
continued

DMH Health and
Safety Overview

1) Increase in Older Adult Surveys from around 400
surveys in the previous survey period to around
760 surveys in this survey period. This was
partly due to the emphasis in the survey training
on collecting enough Older Adult Surveys for SA
comparisons.

2) The Countywide map has been revised. The
report now has 4 different maps by the four
survey types. Each map shows number of
surveys received from each provider location.

3) Data for the County Performance Outcomes by
SA has been consolidated for easier comparison
between the four survey types.

Ms. Levina briefly talked about safety in the
workplace and how patient safety can be impacted
by health and safety of the work environment and
vice versa. Ms. Levina strongly encouraged all
employees to really focus on Health and Safety in
their environment and make suggestions on how to
make it better. DMH Health and Safety Committee
meets every month. Meetings are held at DMH
Headquarters with Service Areas representation.
The committee comes together and discuss health
and safety issues programs are dealing with. Ms.
Levina encouraged staff to report any problems they
might have in the workplace to their supervisors and
managers, and take an active role in safety.

Dr. Joshi mentioned that in order to better
prepare for the Spring 2016 MHSIP
surveys, a random list of providers will be
generated ahead of time so that SA
Liaisons can clarify which provider
numbers provide mostly field-based
services and hence should not be included
in the data collection.

Ms. Levina encouraged staff to report any
problems they might have in the workplace
to their supervisors and managers, and
take an active role in safety.

V. Joshi

A. Levina
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Agenda Item & Discussion & Findings Decisions, Recommendations, Person
Presenter Actions, & Scheduled Tasks Responsible

Patients’ Rights
Office (PRO)

Cultural
Competency
Committee Updates
(CCC)

Mr. Hernandez stated that the Grievance and
Appeals report is finalized. A total of 406 grievances
were noted for the fiscal year. The majority were
quality of care related (90%). Also he mentioned
that the consumer resource directory is completed.
NOA E in Spanish is posted on website. Notice of
Action in Arabic, Armenian, Farsi, Cambodian,
Vietnamese, and Chinese those are translated but
not finalized yet. Mr. Hernandez can be contacted if
there are any questions.

Ms. Parada Ward presented on behalf of Dr. Chang
Ptasinski. Ms. Parada Ward provided an update on
Cultural Competency Committee (CCC). She
mentioned that the CC Unit (CCU) is preparing for
the Systems Review. The CCU is currently working
on several documents and policies needed for the
Systems Review such as the Bilingual Bonus;
Language Interpreters policy. The Cultural
Competency Plan was updated and also the CC
Committee annual report was completed. She also
announced the CCC elected two co-Chairs for this
Calendar Year. The co-chairs are Dr. Leticia
Ximenez and Ms. Berenice Mascher.

Next meeting: February 10, 2016.

M. Hernandez

M. Parada Ward
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Agenda Item & Discussion & Findings Decisions, Recommendations, Person
Presenter Actions, & Scheduled Tasks Responsible

Policy Update —

Mr. Faveau from Compliance Privacy and Audit

Office of Services Bureau provided an update on policies and
Compliance reviewed the handout.
Handouts:

R. Faveau

» Summary Report of Test Calls Study: Monitoring Accessibility to the 24/7 Toll Free Access Line January

2016

» 2013 Psychiatrist Peer Review Medication Monitoring February 2016

» Policy/Procedure Update February 8, 2016

Respectfully Submitted,

Naga Kasarabada, Ph.D.
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